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Spring Competition Image Submissions – TheRCC Spring Competition is already here.  
Image submissions will begin on February 1st and will run through the 15th.   
 
February Field Trip – There is a great field trip planned to The Nethercut Collection & 
Museum on February 18th.  Advanced reservations are required for the tour portion of the trip.  
If you plan to attend, please contact Debra Dorothy by February 11th.  More details are on 
page 5. 
 
ColorMunki – Have your photos submitted for QuickPix, Members’ Night, or competitions not 
looked the way you expected?  The problem is probably a difference in how your computer 
and the club projector display colors and brightness.  You can fix this by calibrating your 
computer the same way our club calibrates our projector – with the ColorMunki.  Set up is 
simple and the calibration process only takes a few minutes.  Contact Beverly Brett at 
bbrett55@hotmail.com to reserve the ColorMunki. 
 
Photogram – If you have photo equipment that you are looking to sell, why not let club 
members know.  Send your submissions to carl.oday.rcc@gmail.com by the third Thursday of 
the month to be included in the following Photogram. 

 

Programs for February & March 2016 

 

Details for the current month’s programs may be found in the Programs article, starting page 3.

  

February 1st February 15th March 7th March 21st 

An Introduction 
to Digiscoping 

With  
Bob Turner 

 

Secrets of Zoo 
Photography 

With 
Ron Garrison  

Spring 
Competition 

Submit Images 
February 1st-15th   

Competition 
Awards 

And Potluck 

PHOTOGRAM 
Monthly Newsletter of the Redlands Camera Club 

February 2016 

Redlands Camera Club meets:  1st & 3rd Mondays, 7:00 pm 
First Presbyterian Church - 100 Cajon St - Redlands, CA 

Guests are always welcome 
 

© Redlands Camera Club & Contributors  The contents of the Photogram are copyrighted.  No material herein may be reproduced in any 
Manner without the written permission of either the Editor or the material’s specific contributor. 

 

mailto:bbrett55@hotmail.com
mailto:carl.oday.rcc@gmail.com
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Carl Detrow 
 
      

 

 
Our VP, Jim Hendon, has been after me for some time to submit a better picture to be used next to 
this column. The old one was not so good, a tripod-based selfie, taken with my wife next to the 
backyard orange tree, and cropped to take out the good parts. I went through my Lightroom library 
and couldn’t find a decent replacement, so I finally gave in and let him shoot me after lunch the other 
day.  I love photography, but for some reason hate to have my picture taken (or “made” as we say in 
some parts of the country.)  
 
It was fun watching Jim work. We went around the corner in downtown Redlands to find one of the 
murals to use as a backdrop. Jim announced that this was the place and I agreed, so he posed me in 
front of it and took several shots. The results were most satisfactory – my wife liked it too.  
 
Why do I so hate having my picture taken? It could be something deep-seated from my childhood, or 
maybe I’ve just never had a good one done. Most shots have been bad snapshots, and that got me 
thinking about what goes into taking a good casual portrait. Portraits have long been the main source 
of income for professional photographers, but what I’m talking about here is the snapshot-portrait of a 
friend or family member on the spur of the moment. 
 
The first thing to think about is location, location, location. Jim chose the spot because it was in full 
shade around the corner. The old days of requiring our subjects to face the sun are long gone. Those 
pictures were always squinty-eyed, and gave the pained expression of not wanting to be there. If 
there is some direct light, position your subject so that it comes from the side. And pay attention to 
exposure. A dark face against a bright background doesn’t flatter the subject. If the lighting needs 
help, consider fill flash, but don’t ever use direct flash as your primary lighting source.  
 
Think about your background. Good portraits focus on the subject, and generally blur the background. 
Think about your subject, and concentrate on him or her. If there’s a beautiful mountain in the 
background don’t try to get both in the same shot. Again, you won’t flatter your subject by being too 
far away to see any detail. Take that landscape later, perhaps using your subject for scale. Jim shot 
me against the mural, but carefully selected a corner of it which would not be too distracting. 
 
Not everybody looks great with a big toothy smile, and I think I’m one of them. Work for a pleasant 
expression, not necessarily a toothpaste ad. Take several shots and have fun doing it. Your 
enthusiasm and joy will find their way to your subject’s face.  
 
Watching Jim work (and listening to Marc Piron last month) has made me a little more enthusiastic 
about photographing people – something new to try in the new year. I hope you’ll try something new 
this year, too. 
 
 
Happy shooting! 
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Jim Hendon 

 

 

February 1
st

 – Introduction to Digiscoping: 
With Bob Turner 

Think you’ve seen it all? Join us Feb. 1 for a special presentation on 
digiscoping -- capturing digital images through a spotting scope – with 
Bob Turner, a former biomedical photographer whose professional 
career spanned more than 40 years. Based in Encinitas, Bob began 
digiscoping about seven years ago as a way to help transition to 
retirement, and now he’s hooked on this powerful and surprisingly 
versatile technology. Bob will review the history of digiscoping (invented 
just 17 years ago); explain his own approach; and share natural-science 
still images and video clips. Bob also 
plans to give us a live digiscoping 

demonstration. Because the digiscope has proven to be a 
powerful tool for wildlife photography, RCC will invite members of 
the San Bernardino Valley Audubon Society to this program. Also, 
we’ll plan to hear from Deb Seibly on the latest from S4C. For 
further information about our speaker’s career and award-winning 
photography visit The Journal of Biocommunication at: 
http://www.jbiocommunication.org/issues/39-1/showcase1.xml 

 

February 15
st

 – Secrets of Zoo Photography: 
With Ron Garrison 

Like no other subject, animals attract the photographer’s eye. They’re 
often hard (or impossible!) to shoot in natural habitats, but zoos and 
wild animal parks give photographers special access. Learn how to 
make the most of these unique environments with Ron Garrison, 
former head of photography for the Zoological Society of San Diego. 
Ron doesn’t call himself a wildlife photographer, but instead a 
“captive animal photographer.” So he’ll share tools, tricks and 
technical tips for working around glass and steel barriers; studying 
and anticipating zoo animal 

behavior; and focusing on the best times, locations and subjects, 
particularly at the San Diego's Zoo and Safari Park. Ron is a former 
U.S. Army and aerospace photographer who spent 38 years in 
photography at the San Diego Zoo. He has photographed animals, 
people and numerous other subjects on seven continents, and his 
work has been widely published. Still an avid shooter, he teaches 
workshops and judges competitions in San Diego County.  
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John Williams

 

 

Thank you for renewing your Membership for Fiscal Year 2015-2016. 
 

We have a total of 153 members in good standing.  Please help make our new members welcome 
and direct them to members who can help them with their photography.  We try to get a brief Bio from 
each of our new members.  Contact me by email (jhwr@earthlink.net) if your Bio has not appeared 
and you wish to have it included. 
Prospective members please note:  You can obtain an application form at one of our regular 
meetings or from our website (www.redlandscameraclub.com), clicking on the “Downloads” tab and 
then clicking on “Membership Application” tab.  Follow the instructions on the form and either bring 
your dues/application form to the next meeting or mail them to the address indicated on the form.  
Dues are the primary source of club revenue allowing us to provide you with quality programs and 
training.  Only currently paid member can take part in RCC classes, events, free workshops, field trips 
and competitions. 
Membership Renewal:  The club's fiscal year begins April 1st and we will start the renewal process 
beginning with the first meeting in March (7th).  There will be a printout of all the data base 
information for you to validate.  Please bring a check made out to Redlands Camera Club or $25 
cash.  
Please welcome our newest members who joined in the month of January: 
 
Gary Applebee   Anna Dewey 
Bill Johnson   Peter King 
Richard O'Donnell   Cristina Turlea 
Xu Xiao-Ping 

  
Rick Strobaugh

 

 

Input From Portfolio Reviews/Members’ Night Critiques  

Four club members did portfolio reviews of quite a few members’ photography recently in a workshop. 
That, along with critiques at the last Member’s Night, several primary suggestions to improve 
photographs was identified. Number one on the list by all was shot selection. Remember, you want to 
have an immediately obvious main subject....of great interest. No matter how perfect I shoot a 
photo of an old bowling ball in my yard, it is still not going to be an attention grabbing photo. You want 
the viewer to feel an immediate, emotional connection to your photo. Second on the list was 
Cropping. Try to always Crop in-camera. Don't include distractions or areas which do not contribute to 
the main subject. Less is almost always, more. The most common distraction was bright areas that 
drew attention away from the main subject. A standard 9x16 crop will often eliminate excessive or 
distracting foreground or sky to focus more attention where you want it. Learn post processing! 
Quite often, simple, basic adjustments would have brought a lot more to a photo.  

mailto:jhwr@earthlink.net
http://www.redlandscameraclub.com/
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Debra Dorothy  

             
 

The Nethercut Collection & Museum 

 

Date:  Febuary 18th Thursday 

Location:  The Nethercutt Museum, 15151 Bledsoe Street, Sylmar, 
CA 91342 

If you have never been to the Nethercut Collection and Museum I 
encourage you to check out their web page at 
http://www.nethercuttcollection.org/ 

Tripods are not allowed. They have no food facilities on the premises. 

ADVANCED RESERVATIONS are required for the tour, so please 
contact me by February 11th if you plan on going so I can call and 

make reservations. If you don't call me you can still go on the trip but you will not be able to 
participate in the tour.  I took the tour recently and I found it to be the most interesting part of the trip. 

We will meet at the Coco's Bakery Restaurant 1140 W Colton Ave, Redlands, CA 92374at 8:00am 
and leave at 8:15 to carpool to event. Please email me ahead of time to let me know if you are 
attending and also if you want to carpool.  Debbiedsd.dorothy@gmail.com 

If you have any questions you can call me at 909 633-2913 or email me at 
Debbiedsd.dorothy@gmail.com 

Hope you all can make it! 

 

 
Stephanie Billings

Gary Applebee 

 

Hi my name is Gary Applebee. I have been coming to the Redlands Camera Club for about three 
meetings. Stephanie asked me how I got the camera bug. I’m not sure I have the bug yet. I got a 
Nikon D3300 camera for Christmas.  

I like to fly fish and backpack. The guys I go backpacking with think if we don’t go for at least a week 

we feel like it’s a waste of time. On these trips I’ve seen some incredible stuff. I thought it would be 

good to get a better camera than my point and shoot to take pictures with so I could show my wife 

who doesn’t backpack. The amazing wonders in the backcountry. I just hope I can remember the big 

round end goes out front and you look in the little eyehole. I’ve got some really good photos of my 

right eye. 
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Frank Peele  
 

RCC School of Photography Courses and Workshops 

 

Advanced Image Editing beginning Tuesday, Feb. 16 
Using Adobe Photoshop software, students will learn how to enhance their digital images to a very 
high standard. Topics covered include Photoshop’s screen layout, tools, adjusting exposure and 
color, working with layers, making selections, retouching, creating panoramas and much more. In 
addition to the capabilities of Photoshop, third-party plugins will be surveyed.  
 
Tuition is $70.  Textbook is Adobe Photoshop CC 2015 Release Classroom in a Book. Class 
sessions are held from 6:00 to 9:00 p.m. Additional meetings of this class will be Feb. 23, Mar. 1, 8, 
15 and 22. 
 
Field Photographic Techniques beginning Tuesday, Apr. 19 at 6:00 p.m.   
This course consists of an introductory classroom meeting and 4 field shooting sessions, each of 
which is followed by a classroom critique of that week’s student photographs. Field sessions will be in 
photogenic locations in and around Redlands, on days and at times arrived at by mutual agreement 
of the class members. Students will photograph a variety of subject matter in differing lighting 
conditions, putting into practice the principles learned in earlier lecture and discussion courses. 
Because of the extensive one-on-one coaching involved, enrollment is limited to 15 students. 
Tuition is $100. Classroom sessions are held from 6:00 to 9:00 p.m. Additional classroom meetings 
will be Apr. 26, May 3, 10 and 17, in addition to the field sessions. 
 
Classes are taught by RCC Past President and Professional Photographers of California Hall of 
Fame member Frank Peele. For full information about these classes or to register, click here. 
If you have specific questions about these classes, call (909) 798-7999 or email Frank at 
educationworkshopsrcc@gmail.com 
 

Workshop: Beyond Automatic 
Today’s digital cameras are marvels of intelligence, getting things like exposure and focus right much 
of the time. The thing no camera can know on its own, however, is just what you want the final 
photograph to capture. In this workshop, we’ll explore how to control your camera and lenses so that 
your images have the right look and feel to express your personal artistic vision. If you’re most 
comfortable in Auto or Program mode, this workshop will show you the expanded possibilities of 
using Aperture Priority, Shutter Priority and Manual modes. Bring your camera and a lens in the wide-
angle to normal focal length range (zoom or fixed focal length). 
 
Date: Monday, Feb. 22, 2016, 6:00 to 9:00 p.m. 
Place: Our usual classroom in the First United Methodist Church, 1 E. Alive Avenue, Redlands 
If you have questions, send an email to educationworkshopsrcc@gmail.com  
  

 

If you have any questions, please email:  educationworkshopsrcc@gmail.com. 

 

http://www.redlandscameraclub.org/education%20workshops.htm
mailto:educationworkshopsrcc@gmail.com
mailto:educationworkshopsrcc@gmail.com
mailto:educationworkshopsrcc@gmail.com
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Wayne (Woody) Wood 

 
 

Nancy Felber  

I have had a mild interest in photography since receiving my first Brownie 
camera for Christmas when I was about ten. I really wanted it, but didn't use 
it much. Years later, when I graduated from college and started teaching, I 
decided to purchase a Polaroid camera for use in the classroom. From 
there, I bought several point and shoot cameras that I used for many years. 
This allowed me to collect "magic moments" of my students throughout the 
school year, to be used in a memory book keepsake for their parents. Not 
much award winning photography going on, but it was a start and it was fun. 

After retiring 13 years ago, my real interest began when my husband Steve 
joined the Redlands Camera Club, and after our first "leaf peeping" RV trip 
to the East Coast with Jerry and Bessie Reese. On this trip, I didn't have a 
camera, so spent many days reading in the car while everyone else had all 

the fun. Upon our return, I also joined the Redlands Camera Club and purchased my first Nikon from 
Bessie. Now my journey of landscape photography had begun. 

I mostly like to photograph landscapes and flowers, as we travel across the country in our RV. From 
the Oregon Coast and the Olympic Peninsula, across the country through Yellowstone and Glacier 
National Parks, to the coasts of Nova Scotia and Prince Edwards Island, The Smokey Mountains and 
back through Moab and Monument Valley, I have come upon numerous photo opportunities. 
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2015 Winter Competition – Second Place 

Club Calendar   

             Information that was available to the editor at the time of publication.  
 

February 1 Introduction to Digiscoping With Bob Turner 

February 1-15 Spring Competition Image Submissions 

February 15 Secrets of Zoo Photography with Ron Garrison 

February 16 Advanced Image Editing course begins 

February 22 Workshop: Beyond Automatic 

March 7 Spring Competition 

March 21 Competition Awards and Pot-luck 

April 19 Field Photographic Techniques course begins 
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Fuji Photo System for Sale  
With Bessie’s passing, I am cutting down on duplicate items. We found the shoot went better if we 
basically had our own equipment and did minimal equipment sharing. 
  
Item                            Asking Price 

X-T1  Body  (weather sealed)           $875 
 

X100T Camera w/23mm f2 lens  $795 

       with accessory LH100 Hood      
  
14mm                                    $650 

27mm                                    $310 

60mm macro                             $400 

18-135mm   (weather sealed)            $630 

55-200mm                               $455 

  
MCEX-11 Extension tube               $50 

MCEX-16 Extension tube               $50 

EF42 Flash                         $100 

RR90 Remote Release                $25 

  

All are in like new to excellent condition 

(The 18-135 was Bessie's go to lens with her X-T1) 
Let me know if you are interested 

  
     Jerry Reece 

     Home: 951-845-2950 

     Cell: 909-223-8052 

     bjreece@verizon.net 

tel:951-845-2950
tel:909-223-8052
mailto:bjreece@verizon.net
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(Note:  The views expressed in this article are those of the author and do not    

necessarily reflect the views of the Photogram or of Redlands Camera Club.) 

 

Adding A Vignette in Adobe Photoshop 
By John Williams 

 
 

1.  Use Camera Raw as a Filter (only available in Adobe Photoshop CC): 

 Open Camera Raw as a filter by choosing Filter>Camera Raw Filter.  Select the Effects tab 
(third from right). 

 Choose a Style: 

 Highlight Priority:  Applies a vignette while protecting highlight contrast but may lead to color 
shift in dark areas of the image. 

 Color Priority:  Applied vignette while preserving color hues but can cause a loss of detain in 
bright highlights. 

 Paint Overlay:  Applies a vignette while blending the image colors with black/white.  Use 
where a soft effect is desired but may reduce highlight contrast. 

 Adjust the vignette using the following sliders: 

 Amount:  Negative values (moving slider left) will darken the vignette and positive values 
lighten the vignette. 

 Midpoint:  A higher value moves the vignette closer to the corners. 

 Roundness:  Positive values results in a more circular vignette while negative values make 
the affect more oval. 

 Feather:  Higher values increase the softening between the affect and surrounding pixels. 

 Highlights:  Controls the degree of highlight punch in bright areas. 
2.  Add a vignette using Adjustment Layer: 

 Add any Adjustment Layer such as Levels.  Change the Blend Mode to Multiply to darken the 
image. 

 Click on the Adjustment layer mask choose Ctrl+I to change the mask to black and hide the 
effect. 

 Select the Brush tool and select White as the Foreground color.  Paint over the corners of the 
image to add a vignette. 

 To reduce the effect. reduce the Opacity. 
3.  Third way to create a Vignette: 

 To add a vignette depress the Create a new layer icon at bottom of Layers panel.  Then 
depress Shift+F5 keys to bring up the Fill dialog box and select Black. 

 Reduce the layer Opacity (65–75%) in order to see the underlining image.  Add a Mask and 
select black for the Foreground color. 

 With a soft edge black brush, paint over the image where you want the viewer attention to be 
directed. 
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 When a vignette is applied to very white areas it will look 
like tone compression or a gray wash.  To protect those 
areas double-click on the right side of the layer to bring up 
the Layers Style Dialog box.  Move the white slider left to 
an approximate value of 235 in order to protect the pure 
white areas.  Split the white slider (hold the Alt key down 
and click on slider) and move the left half of the sider to the 
left until you see highlight areas peek through.  This technique will help prevent washed-out 
highlight areas in the vignette areas. 
Note: you can use this techniquie in the above two described methods. 

 Reduce the layer Opacity to taste (normally 55–60%). 

 Add a subtle blur to the vignette area:  

 Make a stamp layer of all visible layers 
(Ctrl+Shift+Alt+E). 

 Go to Filter>Blur>Gaussian Blur and blur the photo a 
significant amount (Radius to approximately 20-pixels). 

 Move a copy of the Vignette Mask to the blur layer by 
holding down the Alt key and moving the mask up to 
the blur layer. 

Finally, reduce the Layer Opacity to subdue the blur. 

 

 
 
 
 
 

Redlands Camera Club    P.O. Box 7261 Redlands, CA 92375 

www.RedlandsCameraClub.com 
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Publicity: Alex Woodcock         S4C:  Deborah Seibly      

Webmaster: Wayne (Woody) Wood       Welcome:  Stephanie Billings 
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